
   

Tzunami Inc. 
Evaluation Guide  

 

 

Using K-Wise Deployer™ for Rapid 
Content Migration into Microsoft 
SharePoint Products and Technologies 
Rapid migration solutions for Microsoft SharePoint Portal Server 2003 and 

Windows SharePoint Services  

FINAL REVIEW DRAFT – NOT FOR DISTRIBUTION 
 
 

 
Abstract 

K-Wise Deployer is a Microsoft .NET application designed for the rapid content migration from multiple 
sources into Microsoft SharePoint Products and Technologies. 

Rather than being viewed merely as a migration tool, K-Wise Deployer should be viewed as a design 
board for rapid SharePoint construction combined with a  unified application and process that 
streamlines both the construction and migration processes.  

K-Wise Deployer enables organizations using SharePoint to dramatically reduce deployment costs 
while providing better data accountability and content cleansing tools. A typical SharePoint Portal 
Server document migration project can be implemented within one week, while, with a traditional labor 
intensive migration process, it might take several months. 
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Introduction 
K-Wise Deployer is a Microsoft .NET application designed for the rapid content 

migration from multiple sources into Microsoft SharePoint Products and 
Technologies. 

Rather than being viewed merely as a migration tool, K-Wise 
Deployer should be viewed as a design board for rapid SharePoint construction 
combined with an application and process that streamlines the content 
migration process. 

K-Wise Deployer enables organizations using SharePoint to dramatically reduce 
deployment costs. A typical SharePoint Portal Server document migration project 
can be implemented within one week, while, with a traditional labor intensive 
migration process using customer software, it can take several months. 

Acknowledgements 
This evaluation guide was created with the support of Parallelspace Corporation, 

a Tzunami business partner. 
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SharePoint Portal Server 2003 Site Design and Content 
Migration 

K-Wise Deployer (“Deployer”) is the leading tool for modeling Windows 
SharePoint sites and document libraries on a Windows SharePoint Services or 
SharePoint Portal Server 2003 server (or server farm) and for migrating content 
from a number of different source content locations to the SharePoint environment. 
The list of currently supported source content locations includes: 

• Local file systems 
• File servers 
• Exchange public folders 
• SharePoint Portal Server 2001 workspaces 
• Windows SharePoint Services sites 
• SharePoint Portal Server 2003 sites 
• Hyperwave 

This document concentrates on the tasks, activities and steps required to migrate 
content stored on file server to a SharePoint document library in a Windows 
SharePoint Services or SharePoint Portal Server 2003 site. 

Drag and Drop User Interface 
K-Wise Deployer’s drag and drop user interface makes it easy to deploy 

individual files, folders or entire folder hierarchies of content to a SharePoint 
document library. 

Metadata Mapping 
K-Wise Deployer’s metadata mapping features distinguish Deployer from simpler 

tools. Deployer’s GUI-based capabilities enable new custom property sets to be 
designed and for custom SharePoint document libraries to be created based on the 
custom property sets created in Deployer 

KEY FEATURES 
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K-Wise Deployer communicates directly with the source content location. In the 
case of file server content, the source content location may be a local file system or 
a remote file server (see Figure 1). The destination content location is a Microsoft 
Windows server running either Windows SharePoint Services or SharePoint Portal 
Server 2003. 

 

Figure 1. K-Wise Deployer Architecture 

Deployer uses the concept of a project (and corresponding project folder) to store 
all of the information related to a particular content migration project. The project 
folder is a file system folder that is used to store information describing the source 
content location, property sets and the configuration of the destination content 
location. 

 

Figure 2. K-Wise Deployer Application 

The Deployer user interface is depicted in Figure 2. The top half of the project 
window uses a Windows Explorer style folder tree and details tables to display the 
folder and file content that has been loaded from the source content location. The 
bottom half of the project window uses a similar approach to display the structure 
and content of the SharePoint portal sites and team sites on a given SharePoint 

HOW IT WORKS 
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server (or server farm). The details tables in the top and bottom halves of the 
project display the columns of metadata properties and values for each document in 
the currently selected folder. 

The Deployer content migration process is organized into  a series of tasks, 
activities and steps. The four process tasks include: 

• Load 
• Model 
• Deploy 
• Commit 

Each task in turn is broken down into a collection of activities. Each activity is 
described as a series of steps. 

 

Figure 3. K-Wise Deployer Process View 

The Load task involves loading information describing the source content folder 
hierarchy and the metadata properties associated with each document. Loading is a 
read-only operation that reads information from the source content location and 
stores the information in the current Deployer project. Loading does not make 
changes to the source content location. 

The Model task contains the series of activities used to design or modify the 
structure of the destination SharePoint environment. This includes connecting to a 
destination SharePoint server and creating  new SharePoint sites and SharePoint 
document libraries. The configuration of a new site is determined by selecting one 
of the SharePoint site templates available on the server. New SharePoint document 
libraries can be created in an existing or brand-new SharePoint site. In addition to 
sites and document libraries, the Model task can be used to create portal areas and 
subareas in a SharePoint portal site as well as folders and subfolders in a new or 
existing SharePoint document library. The Model task does not make any actual 
changes to the destination SharePoint server. The changes to be applied to the 
destination SharePoint server are not executed immediately. Rather, the changes 
are recorded in the current Deployer project and only applied when a Commit task 
is executed. 

The Deploy task specifies which source folders and files are to be migrated to 
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specific SharePoint document libraries, folders and subfolders on the destination 
SharePoint server. Similar to the Model task, Deployer does not immediately 
migrate the source content to the SharePoint server. The Deploy task records the 
changes to be made to the current Deployer project. The Deploy task content 
migration changes are executed and applied to the destination SharePoint server 
when a Commit task is executed. 

The Commit task causes the orderly execution of the destination content location 
changes to begin. First, the Commit task applies the Model task destination source 
location changes to the SharePoint server. This ensures that the sites, document 
libraries and document library folders have been created in the destination 
SharePoint site before the Deploy task content migration changes are applied. The 
Deploy task content migration changes are applied after the Model task changes. 
The content migration changes are those involved with the physical copying of the 
source content items (for example, Office documents) from the source content 
location to the destination folder in the destination document library in the 
destination SharePoint site. 

More information on using Deployer for specific content migration scenarios is 
found in the section Content Migration Scenarios. Information on how to install 
Deployer is found in the next section, Installation. 
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Software Prerequisites 

Client Workstation 
K-Wise Deployer has been tested with and is supported on computers with the 

following Microsoft Windows configurations: 
• Microsoft Windows Server 2003 
• Microsoft Windows Server 2000 SP2 
• Microsoft Windows XP SP1 or SP2 

Deployer expects to be able to connect to a SharePoint Portal 2003 or Windows 
SharePoint Server 2003 server running the latest release of Windows Server 2003. 
Deployer works with both single server as well as server farm deployments of 
SharePoint Products and Technologies. 

Specific Requirements 

K-Wise Deployer requires and the setup program checks to make sure that 
Microsoft XML 4.0 is installed on the local computer.  Microsoft XML 4.0 can be 
downloaded from the Microsoft Download Center Web site: 
http://www.microsoft.com/downloads/details.aspx?FamilyID=3144b72b-b4f2-46da-
b4b6-c5d7485f2b42&DisplayLang=en.  

SharePoint Server 
K-Wise Deployer has been tested with and is supported on computers with the 

following configurations: 
• Microsoft Windows Server 2003 
• SQL Server 2000 (excluding Windows MSDE (Microsoft SQL Server 

Data Engine) 
• Windows SharePoint Services 
• Microsoft Office SharePoint Portal Serve 2003 

All SharePoint single server as well as server farm configurations described in 
the SharePoint administrator guides are supported. 

Installing K-Wise Deployer 
Installing K-Wise Deployer consists of a single task: installation. 

Installation Task 
Installing K-Wise Deployer consists of two activities: 

• Install 
• Activate 

Install activity 

1. Download the K-Wise Deployer installation files from the Tzunami web site 
(http://www.tzunami.net) to a local file system folder. 

2. Start the setup.exe program by double-clicking on it in Windows Explorer by 
typing the full pathname of the setup.exe program in the Start->Run… dialog box 
and click OK. 

3. The setup.exe program will start and display the following dialog box. 

INSTALLATION 
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4. After the setup.exe program has completed its preparation steps, the following 
dialog box will be displayed. Click Next. 

 

5. Read and review the End-user License Agreement (EULA) when it is displayed. 
Click Yes or No if you accept or don’t accept all the terms of the EULA. 
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6. The following dialog will be displayed allowing you to change the default 
installation folder to be used by setup.exe. Click Browse to change the folder. 
Click Next to continue the installation process. 

 

7. The following dialog appears while the installation process is underway. 
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8. When setup.exe has completed the installation process, the following dialog box 
is displayed. Click Finish. 

 

When the setup.exe program has finished, the following Deployer menu item will 
appear on Windows Start Programs menu. 

 

Activate activity 

K-Wise Deployer installs a default license key that can be used for evaluation 
purposes. To install a new license key, following these steps: 
1. Start Deployer 
2. Click on Tools->License Key … 
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3. The following Deployer License dialog box will be displayed. 

 

4. Enter the new license key and click Update. The following dialog box should 
appear. If you receive an error, contact Tzunami Support by emailing 
mailto:support@tzunami.comsupport@tzunami.com. 

 

5. Click Close on the Deployer License dialog box. 
6. Deployer is now licensed using the new license key. 
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Migrating Content from a File Server into SharePoint Portal 
Server 2003 

The K-Wise content migration process is made up of four tasks, which are 
usually executed in the following order: 

• Load 
• Model 
• Deploy 
• Commit 

The sample content migration files used in these scenarios are described in 
Appendix B – Content Migration Test Files on page 45. 

Assumptions 
1. It is assumed that the existing users already have accounts in the local Active 

Directory domain. 
2. Most Deployer operations can be initiated through the menus, the toolbar or by 

right-clicking on an item to display a pop-up context menu.  In the task and 
activity  descriptions below, the right-click approach for displaying a menu as a 
pop-up menu is used. 

User Permissions 
The user account used to run the Deployer should have the permissions described in 

Table 1. Deployer User Permissions 

Content source The user must have Read permissions in case of file 

shares and Coordinator rights in case of SharePoint 

Portal Server 2001. 

SharePoint Web front-end server The user must have administrator rights on the 

machine (mandatory to analyze the SharePoint 

structure). 

Target SharePoint The user must have full administrator rights for the 

SharePoint site collection or portal site. 

SQL Server The user must have full administrator rights on the 

master and SharePoint databases. 

Active Directory The user must have query rights to get lists of users 

in the target Active Directory domain.. 

The K-Wise Content Migration Process 
An overview of the content migration process can be found in the section How It 

Works on page 4. The following steps, organized by content migration process task, 
describe how Deployer is used to migrate content from a source file server to a 
destination SharePoint server. 

CONTENT MIGRATION 
SCENARIOS 
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Create a New Project activity 

K-Wise Deployer stores all of the information related to a content migration 
project in a Deployer project and project folder. The first step in using Deployer is to 
create a new project. 
1. Start K-Wise Deployer. Before a new Deployer project is created or an existing 

project is opened, Deployer will display an empty window. 

 

2. To create a new project, click File->New… 

 

1. When the New Project dialog box appears, enter a project name and select a file 
system folder where Deployer will store the files it creates for this project. Click 
OK. 
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3. Deployer will create the new project folder and initialize its project files. Deployer 
will display the source content location window in the top half of the project 
window and the destination content location window in the bottom half of the 
project window. Initially both windows are empty. 

 

Load Task 
The Load task involves loading information describing the source content folder 

hierarchy and the metadata properties associated with each document. Loading is a 
read-only operation that reads information from the source content location and 
stores the information in the current Deployer project. Loading does not make 
changes to the source content location. 

Once a new empty project has been created, the next task is to load content and 
metadata from the source content location. 

File Server Load activity 

1. If more than one tab appears above the source content window in the top half of 
the Deployer application, click the File System tab to begin migrating content 
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from a local file system or remote file server. 
2. Right-click in the File System window. When the file system pop-up menu 

appears, select Add Root. 

 

3. When the Add File System Root dialog box appears, enter name to be used for 
the label for the file system folder to be loaded. Click Browse… to select the 
source file system folder to be loaded. 
To enable Deployer to scan and load the metadata associated with each file (in 
addition to the file properties available in the file system directory), check Analyze 
Document Content. If the number of source documents is very large and/or each 
file’s internal metadata does not need to be migrated, leave this option 
unchecked. This will enable Deployer to load the source files as fast as possible. 

 

4. Click OK to start the source content loading process. When the process is 
complete, the folder and files loaded by Deployer will appear in the top window. If 
Analyze Document Content was checked, note the extra metadata fields are 
available for each document that was loaded into the project. 
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Note: Two numbers appear to the right of each folder name in the source content window. The second 
number is a count of the number of source documents that have been loaded from that particular 
folder and all subfolders. The first number is the number of documents remaining to be committed to 
the destination content location. This number will be described in more detail in the Deploy and 
Commit task descriptions. 

 

The Load task is complete when Deployer has finished loading the folders and 
files from the selected source content location. 

Model Task 
The Model task is the series of activities used to design or modify the structure of 

the destination SharePoint environment. This includes connecting to a destination 
SharePoint server and creating new SharePoint sites and SharePoint document 
libraries. The configuration of a new site is determined by selecting one of the 
SharePoint site templates available on the server. New SharePoint document 
libraries can be created in an existing or brand-new SharePoint site. In addition to 
sites and document libraries, the Model task can be used to create portal areas and 
subareas in a SharePoint portal site as well as folders and subfolders in a new or 
existing SharePoint document library. The Model task does not make any actual 
changes to the destination SharePoint server. The changes to be applied to the 
destination SharePoint server are not executed immediately. Rather, the changes 
are recorded in the current Deployer project and only applied when a Commit task 
is executed. 

Once the source content is loaded, the next step is to design the SharePoint 
sites, document libraries and folders where source content is to be migrated to.  

As an alternative, it is also common for the Model task to be organized as a 
separate process with its own Deployer project and project folder; often under the 
direction of another member of the content migration team (for example, by the 
team’s information architect). 

Connect to SharePoint Server activity 

1. To begin the Model task, it is necessary to connect to the destination SharePoint 
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server. Right-click in the bottom destination content location window to display 
the destination content source pop-up menu. Select Connect to SharePoint. 

 

2. The Connect to SharePoint Portal Server 2003 dialog box is displayed. Enter the 
URL for the destination SharePoint server. The server machine name, domain 
name or IP address can be used. Select the user account to be used by 
Deployer to login and access the destination SharePoint server. The selected 
user account must be member of the Administrator role for the top-level 
SharePoint site collection on the SharePoint server. Click OK. 

 

3. Deployer will begin to scan the destination SharePoint server and load 
descriptive information about each SharePoint portal site, team site, ‘My Site’ 
personal site, portal area and listing, document library, folder and file on the 
SharePoint server. 



 

 Using K-Wise Deployer™ for Rapid Content Migration into Microsoft SharePoint Products and 

Technologies 18 

 

4. Clicking on a SharePoint site, document library, folder or file on the left-side of 
the destination content window will display the metadata for the item in the right-
side of the window. 

 

Create a New SharePoint Site activity 

1. To create a new SharePoint site in your Deployer project, create a new Deployer 
project or open an existing Deployer project (see Create a New Project activity 
on page 13). When an existing project is opened and the project contains a 
previous SharePoint connection, Deployer will automatically connect to the 
destination SharePoint Server; otherwise, connect to the SharePoint Server (see 
Connect to SharePoint Server activity). 

2. Right-click on a portal or team site to display the modeling pop-up menu. Scroll 
down the menu until New is highlighted. Select Site from the New pop-up menu. 



 

 Using K-Wise Deployer™ for Rapid Content Migration into Microsoft SharePoint Products and 

Technologies 19 

 

3. The New WSS Site dialog box will be displayed. Enter the URL, title, description, 
owner account to be used for the new SharePoint Site. Select the language and 
team site template to be used. 

 

4. The new SharePoint site will appear in the bottom half of the project window.  
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5. At this point, the new site has been added to the Deployer project but Deployer 
has not applied the changes to the SharePoint server. The Deployer project 
enables you to model a complete SharePoint server configuration before 
physically committing it to your SharePoint server.  
Once an initial connection has been made to a SharePoint server and the 
SharePoint server configuration has been saved in a Deployer project, further 
modeling work can be completed offline or off-site – without requiring a live 
connection to the SharePoint server. 
When the Model task is complete, the changes in the Deployer project need to 
be physically committed to the SharePoint server. This is described in the 
Commit the Changes to the SharePoint Server activity on page 31. 

Create a New Folder in a SharePoint Document Library activity 

1. To create a new folder in an existing SharePoint document library on an existing 
SharePoint site, open an existing Deployer project (see Create a New Project 
activity on page 13). 

2. Right-click on the document library in the SharePoint site to display the modeling 
pop-up menu. Scroll down the menu until New is highlighted. Select Folder from 
the New pop-up menu. 
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3. A new folder called “New Folder” will be added to the highlighted document 
library. 

 

4. To rename the folder, right-click on the folder to display the modeling pop-up 
menu and select Rename. Enter the new name for the folder and click OK. 

5. A subfolder can be created inside an existing folder by right-clicking on the folder 
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and selecting New and then selecting Folder from the New pop-up menu. 
6. At this point, the new folder has been added to the Deployer project but Deployer 

has not applied changes to the SharePoint server. When the modeling 
SharePoint server configuration is complete, the changes in the Deployer project 
need to be physically committed to the SharePoint server. This is described in 
the Commit the Changes to the SharePoint Server activity on page 31. 

Create a New Document Library in a SharePoint Site activity 

1. To create a new document library in an existing SharePoint site, open an existing 
Deployer project (see Create a New Project activity on page 13). 

2. Right-click on the SharePoint site to display the modeling pop-up menu. Scroll 
down the menu until New is highlighted. Select Document Library from the New 
pop-up menu. 

 

3. A new document library called Document Library will be added to the SharePoint 
site. 
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4. To rename the document library, right-click on the document library to display the 
modeling pop-up menu and select Rename. Enter the new name for the 
document library and click OK. 

5. Folders and subfolders can be created inside a document library by right-clicking 
on a document library or one of its sub folders and selecting New and then 
selecting Folder from the New pop-up menu. See Create a New Folder in a 
SharePoint Document Library activity on page 20 for more details. 

6. At this point, the new document library has been added to the Deployer project 
but Deployer has not applied changes to the SharePoint server. When the 
modeling SharePoint server configuration is complete, the changes in the 
Deployer project need to be physically committed to the SharePoint server. This 
is described in the Commit the Changes to the SharePoint Server activity on 
page 31. 

Create a New Portal Area activity 

1. To create a portal area in an existing SharePoint portal site, open an existing 
Deployer project (see Create a New Project activity on page 13). 

2. Click on the portal site and then click on Home to display the list of top-level 
topics in the portal site. The default portal areas are called News, Sites and 
Topics. 

3. Right-click on the Topics portal area (or a subarea) to display the modeling pop-
up menu. Scroll down the menu until New is highlighted. Select Area from the 
New pop-up menu. 
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4. A new portal area called “New Area” will be added to the highlighted Topics area 
(or subarea). 

 

5. To rename the portal area, right-click on the portal area to display the modeling 
pop-up menu and select Rename. Enter the new name for the portal area and 
click OK. 

6. At this point, the new portal area has been added to the Deployer project but 
Deployer has not applied changes to the SharePoint server. When the modeling 
SharePoint server configuration is complete, the changes in the Deployer project 



 

 Using K-Wise Deployer™ for Rapid Content Migration into Microsoft SharePoint Products and 

Technologies 25 

need to be physically committed to the SharePoint server. This is described in 
the Commit the Changes to the SharePoint Server activity on page 31. 

Deploy Task 
The Deploy task specifies which source folders and files are to be migrated to 

which specific SharePoint document libraries, folders and subfolders on the 
destination SharePoint server. Similar to the Model task, Deployer does not 
immediately migrate the source content to the SharePoint server. The Deploy task 
records the changes to be made to migrate the source content in the current 
Deployer project. The Deployer content migration changes are executed and 
applied to the destination SharePoint server when a Commit task is executed. 

Deploy Source File Server Content activity 

1. To deploy all or part of the file server content loaded into Deployer during the 
Load task, begin by opening the correct project in Deployer (see Create a New 
Project activity on page 13). 

2. The top half of the project window will display the folders, subfolders and files 
that were added to the project during a previous Load task. If the top half of the 
project window is empty, the file server content will need to be loaded before 
proceeding. Use the File Server Load activity on page 14 to do this. 

3. The bottom half of the project window should display the SharePoint sites and 
document libraries that were added to the project during a previous Model task. If 
the bottom half of the project window is empty, the configuration of the 
destination SharePoint server must be added to the project. Use the Connect to 
SharePoint Server activity on page 16 to do this. If additional SharePoint sites or 
document libraries need to be added to the destination SharePoint server before 
the source file server content is deployed, use the activities in the Model Task on 
page 16 to do this. 

 

4. To begin the deployment of the source file server content to one or more 
SharePoint document libraries in one or more SharePoint sites, click on a file 
server folder (or select a group of files) in the top half of the project window and, 
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holding the left mouse button down, drag the folder or collection of files over top 
of a document libraries in the bottom half of the project window. Release the left 
mouse button. Deployer will be start the Deploy task by displaying the Deploy To 
SharePoint dialog box. 

Note: The deploy activity (dragging and dropping content from the file server content in a project to the 
SharePoint site and document configuration in the project does not cause any content or other 
changes to be physically written to the destination SharePoint server. Changes are only written to the 
destination SharePoint server during a Commit task. Changes that are made during a Model or Deploy 
task are recorded in the Deployer project. A Commit task must be used to have these changes applied 
to the destination SharePoint server. 

5. If a folder is dragged and dropped on a destination document library, the Deploy 
to SharePoint dialog box will be displayed. Several options are available to 
control where and how subfolders are handled: 

a. Select the destination folder or subfolder where the folders and file items 
are to be deployed. 

b. If the Deploy sub folders option is checked, all subfolders from the source 
file server will be deployed as subfolders in the destination SharePoint 
document library. If the Deploy sub folders option is not checked, only the 
folder that was dragged and dropped into the destination document library 
will be deployed. 

c. If the Deploy folder documents option is checked, the documents in each 
source file server folder will be deployed. If the Deploy folder documents 
option is not checked, only the subfolder hierarchy is created and the 
documents in each subfolder are not copied to the destination document 
library. 
If Deploy sub folders is not checked and Deploy folder documents is 
checked, only the documents in the folder that was dragged and dropped 
into the destination Document library will be deployed. No subfolders (and 
no documents in the subfolders) will be deployed. 

d. If the Flat Deploy option is checked, the folder structure in the source file 
server is ignored. All documents in the source file server folder (and 
potentially all subfolders) will be deployed into the destination SharePoint 
document library folder. Documents will not be copied to any subfolders. 

e. When the Flat Deploy option is checked and documents in one or more 
subfolders have the same name, Deployer needs to know how to handle 
the situation where a document with the same name as a previous 
document might be overwritten. The Duplicate names handling options tell 
Deployer either skip the item, overwrite the existing item or save the new 
item with a numeric suffix added to the name. 

6. Once the appropriate Deploy To SharePoint options have been selected, click 
OK. 
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7. When the metadata property set for the source file server does not match the 
metadata property set for the destination SharePoint document library, the Map 
Properties dialog box is displayed. Properties with the same name are 
automatically matched and appear in the Mapped Properties list. The source and 
destination properties that were not mapped automatically can be mapped 
manually by selecting a source property and its corresponding destination 
property and clicking Map. This can be repeated as many times as required. 

 

8. Clicking on Details will display a list of folders that use the selected property. 
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9. Clicking on Map Values… will display the Map Values dialog box for the selected 
property. This dialog box can be used to maps specific source values for a 
metadata field to specific destination (target) values. Select a source value and a 
target value and click Map. 

 

10. Repeat the previous step to map any additional source values. Click OK to close 
the Map Values dialog box. 
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11. Once the metadata properties and metadata property values have, optionally, 
been mapped, click OK on the Map Properties dialog box to start the deployment 
of the source folders and files into the selected SharePoint document library. 

Note: Changes are only written to the destination SharePoint server during a Commit task. Changes 
that are made during a Deploy task are recorded in the Deployer project. A  Commit task must be 
used to physically apply these changes to the destination SharePoint server. 

 

12. If Deployer is unable to deploy one or more source folders or files to the 
destination SharePoint document library, the following Warning dialog box will be 
displayed. The most frequent reasons for not being able to deploy a folder or 
document are: 
• The folder or file pathname is too long. 
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• A folder name or path name contains illegal characters. 
• The file is an Internet shortcut file (.url suffix). 
Additional folder and file naming considerations can be found in Appendix A - 
Folder and File Naming Considerations on page 41. 

 

13. When Deployer has finished deploying the source files and folders to the 
destination document library, the new folders and files will appear in the lower-
half of the project window. 

 

14. Clicking on one of the new folders will display a table of subfolders and files 
contained in that folder. The name of the item will appear in the first column. The 
metadata property values copied to the destination document library will appear 
in the adjacent columns. 
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15. The Deploy task is complete. 
At this point, the changes have been recorded in the Deployer project but 

Deployer has not applied changes to the SharePoint server. When all of the content 
to be deployed has been dragged and dropped into the appropriate SharePoint 
document libraries, the changes in the Deployer project need to be physically 
committed to the SharePoint server. This is described in the Commit the Changes 
to the SharePoint Server activity on page 31. 

Commit Task 
The Commit task causes the orderly execution of the destination content location 

changes to be begin. First, the Commit task applies the Model task destination 
location changes to the SharePoint server. This ensures that the sites, document 
libraries and document library folders have been created in the destination 
SharePoint site before the Deploy task content migration changes are applied. The 
Deploy task content migration changes are applied after the Model task changes. 
The content migration changes are those involved with the physical copying of the 
source content items (for example, Office documents) from the source content 
location to the destination folder in the destination document library in the 
destination SharePoint site. 

Commit the Changes to the SharePoint Server activity 

1. To physically commit any changes in a Deployer project to a SharePoint server, 
open the Deployer project. When an existing project is opened and the project 
contains a previous SharePoint connection, Deployer will automatically connect 
to the destination SharePoint Server. 
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2. To start the commit activity, right-click on a portal or team site to display the 
modeling pop-up menu. Select Commit to SharePoint. 

 

3. The following dialog box will be displayed warning you that Deployer is going to 
save the current project data to disk. Click Yes to continue. 
If you want to save your project data under a new name, click No and use File 
Save As… to save the project data with a new project name. Then go to the 
previous step to resume the commit activity. 
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4. After the project has been saved to disk, Deployer prompts one more time before 
making any physical changes to the SharePoint server. If you want all changes in 
the project since the last commit activity or in the case of a new project, all of the 
changes since the project was created, click Yes. 

 

5. Deployer will display the following progress dialog box indicating the number of 
change operations that have been made to the SharePoint server. 

 

6. A summary of the changes that were committed to the SharePoint server will be 
displayed at the end of the commit activity. 
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7. This ends the Commit task. Right-click on the new SharePoint site or document 
library and select Open to view the site or document library using Internet 
Explorer. 
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Deployer is a powerful end-to-end solution for migrating content, metadata and 
folder structures into SharePoint sites but it is also very useful for more specific 
SharePoint management and metadata management tasks including: 
• Offline modeling of SharePoint infrastructures 
• Managing metadata mappings 

Offline Modeling of Your SharePoint Environment 
The Model task can be used independently of the other Deployer tasks to initially 

model a new SharePoint infrastructure or manage and update an existing 
SharePoint environment. Simply connect to the destination SharePoint server to 
collect the current configuration information in a Deployer project. A business 
analyst can then work offline with the Deployer project to make the necessary 
modifications to the SharePoint environment. All resulting changes will be captured 
in the project and a Commit task can be used online to apply the complete set of 
changes to the SharePoint server. 

Managing Metadata Mappings 
The Metadata Editor enables Deployer users to model the source-to-destination 

property and property value mappings in advance of using the Deploy task. 

Metadata Editor Activity 

1. Selecting Metadata Editor on the View menu of an open project will display 
Deployer’s Metadata Editor for the current source content location (for example, 
File System).  

 

2. To edit a particular Deployer column set of property fields, right-click on the 
column set name to display the Metadata Editor pop-up menu. 

ADDITIONAL 
SCENARIOS 
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3. Select Map Property Set to display the Map Properties dialog. 

 

4. Follow the steps described in the Deploy Source File Server Content activity on 
page 25 to change the property field and property value mappings. 
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Options Dialog Box 
The Options menu item on the Deployer Tools menu can be used to specify a 

number of options that affect overall Deployer operation. The Options dialog 
enables the following settings to be edited: 
• Auto save 
• Log file 
• Deployment 
• Cluster tree 
• SharePoint 2003 

Save Options 
The Save settings on the Options dialog can be used to enable the automatic 

saving of a project to the hard disk. 

 

Log Options 
The Log settings control the type and amount log information that is written to the 

project folder. 

 

Deploy Options 
The Deploy settings control when the Map Properties and Map Values dialogs 

are displayed. 

DEPLOYER 
APPLICATION OPTIONS 
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For source content collections that support versioning (for example, SharePoint 
Portal Server 2003), the Deploy settings are also used to control how multiple 
versions of source files are to be handled during the Deploy task. 

 

Cluster Tree Options 
Cluster tree settings specify how file metadata in the source file collection is to be 

used during clustering. 

 

SharePoint 2003 Options 
The SharePoint 2003 settings control the file upload timeout value and whether 

trusted domain user accounts are to be used when setting ownership property 
values. 
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Frequently Asked Questions 

1. Where does K-Wise Deployer store a project? 
 
Answer: During the Create a New Project activity, the project is given a 
name and a project folder location. A project is stored in a project folder 
created in the supplied project folder location. The project folder name is 
the same as the name of the project. 

 

Troubleshooting 

1. When I use Deploy to load, model, deploy and commit an entire collection 
of files from a source content location to a SharePoint document library, 
some of the files appear to be missing.  Where are they? 
 
Answer: The most common reasons for files not being migrated to the 
destination SharePoint document library are: 
• The folder or file pathname is too long. 
• A folder name or path name contains illegal characters. 
• The file type appears in the SharePoint blocked file type list and, 

hence, the file could not be uploaded to a SharePoint document 
library 

• The size of the file to be migrated is greater than the maximum file 
upload size for the SharePoint site. 

 

For More Information 
For more information on K-Wise Deployer, visit http://www.Tzunami.net.  
 
 

MORE INFORMATION 
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To ensure a smooth migration of a collection of files stored in folders and 
subfolders on a local file system or remote file server, one best practice is to make 
sure your folder, file and path names conform to the following limits and other 
restrictions. 

Folder path and fully qualified file name lengths 

Context 
A fully qualified file name consists of two parts: 
• File name including the file base name and file suffix 
• Folder path for the fully qualified file name 
The filename is the last component of a fully qualified file name. The folder path 

for a fully qualified file name starts with the partition’s drive letter and includes 
everything up to the filename and the last folder character (e.g. ‘\’ or ‘/’). 

Restrictions – Microsoft Windows 
• The fully qualified file name can have a maximum length of 260 characters. 
• The maximum length of a folder path portion of a fully qualified file name is 

248 characters. 

Restrictions – Microsoft SharePoint Portal Server 2003 
• The fully qualified file name can have a maximum length of 255 characters 

in Windows. 
• The maximum length of a folder component is 30 characters. 

Discussion 
• Normally, it is not possible using Windows Explorer or a Windows 

application to create folder paths and fully qualified file names that are too 
long. However, it is possible under the following scenarios: 
• A subfolder 1 or more levels below the root of the file system is shared 

as UNC file share. Then it is possible to create an entire new folder 
hierarchy under the root of the file share that can store files using fully 
qualified file name that are a further 260 characters long. 

• Similarly, the subst command can be used to anchor a drive letter at a 
subfolder 1 or more levels below the root of the file system. 

• Using Unicode fully qualified file names prefixed with the letters “\\?\”. 
When this approach is used, fully qualified path names can be 32,000 
characters in length. 

Unsupported characters in folder and file names 
The following characters are not supported in Windows SharePoint Services: 
/\:*?"<>|#{}%&~ or tab characters and multiple periods. 
 
If a file, folder, or URL name in your original site contains one of these 

characters, it is usually replaced with an underscore (_). 
Two exceptions are: 
• Character ‘#’ (pound sign) which can be replaced with the word “No.” 

APPENDIX A - FOLDER 
AND FILE NAMING 
CONSIDERATIONS 
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• Character & which can be replaced with the word “and” 
Multiple periods are replaced with a single period. 
Additional digits may be appended to the file or folder name if there are 

conflicting renaming changes. 
Files or folders with trailing spaces at the very end of a filename ("filename.doc ") 

are not supported in Windows SharePoint Services. You must change the file name 
and then add the file manually to your site. 

Blocked file types 
Windows SharePoint Services (and in turn, SharePoint Portal Server 2003) have 

the ability to block certain file types from being uploaded or otherwise stored in a 
document library. 

The following is the default list of file types (based on a file’s suffix) that are 
blocked from being uploaded or otherwise stored into a SharePoint document 
library. 

Table 2. SharePoint default blocked file types 

File 
extension 

File type 

.ade Microsoft Access project extension 

.adp Microsoft Access project 

.app Application file 

.bas Microsoft Visual Basic class module 

.bat Batch file 

.chm Compiled HTML Help file 

.class Java class file 

.cmd Microsoft Windows NT Command Script 

.com Microsoft MS-DOS program 

.cpl Control Panel extension 

.crt Security certificate 

.dll Windows dynamic link library 

.exe Program 

.fxp Microsoft Visual FoxPro compiled program 

.hlp Help file 

.hta HTML program 

.ins Internet Naming Service 

.isp Internet Communication settings 

.jse JScript Encoded Script file 

.lnk Shortcut 

.mda Microsoft Access add-in program 

.mdb Microsoft Access program 

.mde Microsoft Access MDE database 

.mdt Microsoft Access data file 

.mdw Microsoft Access workgroup 

.mdz Microsoft Access wizard program 

.msc Microsoft Common Console Document 

.msi Microsoft Windows Installer package 
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.msp Windows Installer patch 

.mst Visual Test source files 

.ops Microsoft Office profile settings file 

.pcd Photo CD image or Microsoft Visual Test compiled script 

.pif Shortcut to MS-DOS program 

.prf System file 

.prg Program source file 

.reg Registration entries 

.scf Windows Explorer command file 

.scr Screen saver 

.sct Windows Script Component 

.shb Windows shortcut 

.shs Shell Scrap Object 

.url Uniform Resource Locator (Internet shortcut) 

.vb Microsoft Visual Basic Scripting Edition (VBScript) file 

.vbe VBScript Encoded Script file 

.vbs VBScript file 

.wsc Windows Script Component 

.wsf Windows Script file 

.wsh Windows Script Host Settings file 

 
The following sections contain the character limitations that apply to various user-

specified parameters in Microsoft Office SharePoint Portal Server 2003. 

Other Naming Considerations 

Portal Site 

Portal site name 

The portal site name is limited to 80 Unicode characters.  
The portal site name can consist of all alphanumeric characters except for the 

following: \ / : * ? " < > | 

Portal site description 

The portal site description is limited to 200 Unicode characters.  
The portal site description can consist of all alphanumeric characters, as well as 

the following: # % * + \ | " ? $ @ [ ] { } ¦ 

Portal site logo 

The URL for the portal site logo is limited to 256 ASCII characters. 
The URL for the portal site logo can consist of all alphanumeric characters 

except for the following: # % * + \ | " ? > < $ @ [ ] { } ¦ 
The following file formats are supported for the graphics file: .gif, .bmp, .jpg, and 

.png. TIFF files are not supported. 

Portal site URL 

The URL for the portal site is limited to 255 characters for the entire URL, 
including virtual directories. 



 

 Using K-Wise Deployer™ for Rapid Content Migration into Microsoft SharePoint Products and 

Technologies 44 

Account name for portal site owner 

The account name is limited to 128 characters. 

E-mail address for portal site owner 

The e-mail address is limited to 255 characters. 

Location for creating SharePoint sites 

The URL for creating sites from the Site Directory is limited to 2,048 ASCII 
characters. In addition, no component of the URL, such as the virtual directory or 
virtual server, can exceed 128 characters. 

The URL must end with /_layouts/language/scsignup.aspx. 

Backward-Compatible Document Library (Web Storage System-Based)  

Document library friendly name 

The friendly (display) name cannot exceed 100 characters in length. 

Alternate Portal Site Access Mappings 

Mapping name 

The mapping name has a maximum length of 64 Unicode characters and must 
not be null. 

The following character limitations apply for the default, intranet, extranet, and 
custom URLs: 

Each URL has a maximum length of 255 Unicode characters and a minimum 
length of 5 characters. 

The user can enter the URL in any combination of uppercase and lowercase 
letters, but the URL is always saved in lowercase. 

Each URL must be different from all other URLs. 

Content Index 

Content index name 
The content index name must be less than 50 characters. 
The content index name cannot contain the following characters: + ~ # ' % * ( 

) = [ ] { } | \ " < > . ? / @ & or the euro symbol or a space. 
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The sample content migration files used in these activities are a set of 19 
different file types. Each sample file was created to be a small as possible example 
of that particular file type. This makes this set of files ideal for training and testing. 

An archive file containing all 19 file can be downloaded from: 
 http://www.parallelspace.net/sharepoint/deployer  

Registration is required. 

 

 

APPENDIX B – CONTENT 
MIGRATION TEST FILES 
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In a K-Wise Deployer context, working inside a firewall means there is no firewall 
installed between the client workstation running the Deployer, the source content 
location (for example, a source file server) and the target SharePoint environment. If 
the client workstation, source content location and the target SharePoint 
environment are on different local area networks (LANs), the only requirement is for 
the different LANs to be inter-networked. Connection speeds of 10 Mbit are 
acceptable; 100 Mbit or higher connections are preferred.  

Working outside a firewall means at least one (but not all) of the client 
workstations running the Deployer, the source content location (for example, a 
source file server) or the target SharePoint environment is installed behind a 
firewall. In this scenario, the firewall needs to be configured (temporarily) to open 
the specific ports necessary to connect Deployer, running on the client workstation, 
with the source content location, the SQL Server database server and the target 
SharePoint environment.  These ports are described in Table 3, Table 4 and Table 
5. 

Table 3. SharePoint port assignments 

Any ports used by a Web load balancing solution that sits in front the SharePoint Web front-
end servers. 

SharePoint virtual server ports.  Port 80 is the default port.  Additional virtual servers may 
use additional IP addresses and/or ports. 

SharePoint Central Administration Site port.  This port is configured at SharePoint 
installation time to a random port number. The SharePoint Central Administration Site port 
can be found by inspecting the URL for the SharePoint Central Administration Site web 

page or by using the Microsoft Internet Information Server (IIS) Manager. 

 

Table 4. NETBIOS default port assignments 

Service Port Description 

Netbios-ns  137/tcp  nbname #NETBIOS Name Service 

Netbios-ns  137/udp nbname #NETBIOS Name Service 

Netbios-dgm 138/udp nbdatagram #NETBIOS Datagram Service 

Netbios-ssn 139/tcp nbsession #NETBIOS Session Service 

Microsoft-ds 445/tcp  

Microsoft-ds 445/udp  

Table 5. SQL Server default port assignments 

Service Port Description 

Ms-sql-s  1433 #Microsoft-Sql-Server 

JDL-DBKitchen 3086 #SQL 

 

APPENDIX C – USING 
DEPLOYER ACROSS A 
FIREWALL 


